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Introduction to Cluster Services

NetWare Cluster Services is a server clustering system that ensures high 
availability and manageability of critical network resources including data 
(volumes), applications, server licenses, and services. It is a multinode, NDS-
enabled clustering product for NetWare 5 that supports failover, failback, and 
migration (load balancing) of individually managed cluster resources.
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Overview

NetWare® Cluster ServicesTM is a server clustering system that ensures high 
availability and manageability of critical network resources including data 
(volumes), applications, server licenses, and services. It is a multinode 
clustering product for NetWare 5 that is enabled for NDSTM and supports 
failover, failback, and migration (load balancing) of individually managed 
cluster resources.

Product Features

NetWare Cluster Services includes several important features to help you 
ensure and manage the availability of your network resources. These include:

� Support for shared SCSI or fiber channel storage area networks.

� Multinode all-active cluster (up to 32 nodes). Any NetWare server in the 
cluster can restart resources (applications, services, IP addresses, and 
volumes) from a failed server in the cluster.

� Single point of administration through a Java-based ConsoleOneTM 
cluster configuration and monitoring GUI.

� The ability to tailor a cluster to the specific applications and hardware 
infrastructure that fit your organization.

� Dynamic assignment and reassignment of server storage on an as- needed 
basis.
Overview �

Overview and Installation
Place Part Number Here

February 5, 2001



Manual Rev 99a28 9 June 00
Product Benefits

NetWare Cluster Services allows you to configure up to 32 NetWare 5 servers 
into a high-availability cluster, where resources can be dynamically switched 
or moved to any server in the cluster. Resources can be configured to 
automatically switch or be moved in the event of a server failure, or can be 
moved manually to troubleshoot hardware or balance the workload.

NetWare Cluster Services provides high availability from commodity 
components. Lower costs are obtained through the consolidation of 
applications and operations onto a cluster. The ability to manage a cluster from 
a single point of control and to adjust resources to meet changing workload 
requirements (thus, manually “load balance” the cluster) are also important 
benefits of NetWare Cluster Services.

An equally important benefit of implementing NetWare Cluster Services is 
that you can reduce unplanned service outages and reduce planned outages for 
software and hardware maintenance and upgrades.

Reasons you would want to implement NetWare Cluster Services include:

� Increased availability

� Improved performance

� Low cost of operation

� Scalability

� Disaster recovery

� Data protection

� Shared resources

Shared disk fault tolerance can be obtained by implementing RAID Level 5 
on the shared disk subsystem.

An example of the benefits NetWare Cluster Services provides can be better 
understood through the following scenario.

Suppose you have configured a three-server cluster, with a Web server 
installed on each of the three servers in the cluster. Each of the servers in the 
cluster hosts two Web sites. All the data, graphics, and e-mail messages for 
each Web site is stored on a shared disk subsystem connected to each of the 
servers in the cluster. The following figure depicts how this setup might look.
�� Overview and Installation
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During normal cluster operation, each server is in constant communication 
with the other servers in the cluster and performs periodic polling of all 
registered resources to detect failure. 

Suppose Web Server 1 experiences hardware or software problems and the 
users depending on Web Server 1 for internet access, e-mail, and information 
lose their connections. The following figure shows how resources are moved 
when Web Server 1 fails.

Web Site A moves to Web Server 2 and Web Site B moves to Web Server 3. 
IP addresses and applicable licenses also move to Web Server 2 and Web 
Server 3.
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When you configured the cluster, you decided where the Web sites hosted on 
each Web server would go should a failure occur. In the previous example you 
configured Web Site A to move to Web Server 2 and Web Site B to move to 
Web Server 3. This way, the workload once handled by Web Server 1 is evenly 
distributed.

When Web Server 1 failed, NetWare Cluster Services software

� Detected a failure.

� Restarted applications (that were running on Web Server 1) on Web 
Server 2 and Web Server 3 as specified.

� Transferred IP addresses to Web Server 2 and Web Server 3 as specified.

� Remounted the shared data volumes (that were formerly mounted on Web 
server 1) on Web Server 2 and Web Server 3 as specified.

In this example, the failover process happened quickly and users regained 
access to the Internet, Web site information, and e-mail within seconds, and in 
most cases, without having to log in again.

Now suppose the problems with Web Server 1 are resolved, and Web Server 
1 is returned to a normal operating state. Web Site A and Web Site B will 
automatically failback, or be moved back to Web Server 1, and Web Server 
operation will return back to the way it was before Web Server 1 failed.

NetWare Cluster Services also provides resource migration capabilities. You 
can move applications, Web sites, etc. to other servers in your cluster without 
waiting for a server to fail.

For example, you could have manually moved Web Site A or Web Site B from 
Web Server 1 to either of the other servers in the cluster. You might want to do 
this to upgrade or perform scheduled maintenance on Web Server 1, or just to 
increase performance or accessibility of the Web sites.

Cluster Configuration

Typical cluster configurations normally include a shared disk subsystem 
connected to all servers in the cluster. The shared disk subsystem can be 
connected via high-speed fiber channel cards, cables, and switches, or be 
configured to use shared SCSI. If a server fails, another designated server in 
the cluster automatically mounts the shared disk volumes previously mounted 
on the failed server. This gives network users continuous access to the 
volumes on the shared disk subsystem.
�� Overview and Installation
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Typical resources might include data (volumes), applications, server licenses, 
and services. The following figure shows how a typical fiber channel cluster 
configuration might look.

Although fiber channel is the recommended configuration, you can configure 
your cluster to use shared SCSI. The following figure shows how a typical 
shared SCSI cluster configuration might look.
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Cluster Components

The following components make up a NetWare Cluster Services cluster:

� From 2 to 32 NetWare 5 servers configured to use IP, each containing at 
least one local disk device (used for a local SYS: volume).

� NetWare Cluster Services software running on each NetWare 5 server in 
the cluster.

� A shared disk subsystem connected to all servers in the cluster (optional, 
but recommended for most configurations).

� High-speed fiber channel cards, cables, and switch or SCSI cards and 
cables used to connect the servers to the shared disk subsystem.
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Installation and Setup

Hardware Requirements

The following list specifies hardware requirements for installing NetWare® 
Cluster ServicesTM. These requirements represent the minimum hardware 
configuration. Additional hardware might be necessary depending on how 
you intend to use NetWare Cluster Services.

� A minimum of two NetWare 5 servers. A maximum of eight servers per 
cluster is enforced for this release.

� At least 128 MB of memory on all servers in the cluster (256 MB 
recommended for failing multiple applications to the same server).

� At least one local disk device (not shared) for volume SYS: on each 
server.

Software Requirements

You must have the NetWare 5 Support Pack 4 or later running on each cluster 
server. You can install Support Pack 4 for NetWare 5.0 from the NetWare 
Cluster Services product CD. If you are not installing from CD, you can 
download Support Pack 4 from Novell’s Support Connection Web site (http:/
/www.support.novell.com/misc/patlst.htm#nw). Ensure the following 
requirements are met:

� All servers in the cluster configured with the IP protocol and on the same 
IP subnet.

� All servers in the cluster in the same NDSTM tree.

� The Novell® ClientTM included on the NetWare Cluster Services product 
CD installed on the workstations used to manage and access your cluster.

� ConsoleOneTM installed (from the NetWare Cluster Services product CD) 
on the workstation used to manage your cluster.
Installation and Setup ��
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Shared Disk System Requirements

A shared disk system is required for each cluster if you want data to be highly 
available. If a shared disk subsystem is used, ensure the following:

� At least 10 MB of free disk space on the shared disk system for creating 
a special cluster partition.

The NetWare Cluster Services installation automatically allocates one 
cylinder on one drive of the shared disk system for the special cluster 
partition. If the drive where the cluster partition is to be created on the 
shared disk system is larger than 10 GB, you may need more than 10 MB 
of free space.

� The shared disk system is properly set up and functional according to the 
manufacturer’s instructions.

Prior to installation, verify that all the drives in your shared disk system 
are recognized by NetWare by running the List Devices command on 
each server you intend to add to your cluster. If any of the drives in the 
shared disk system do not show up in the list, consult your NetWare 5 
documentation or the shared disk system documentation for 
troubleshooting information.

� The disks contained in the shared disk system are configured in a 
mirroring or RAID 5 configuration to add fault tolerance to the shared 
disk system.

:$51,1*��If the disks in the shared disk system are not configured to use 
mirroring or RAID 5, a single disk error can cause a volume failure. NetWare 
Cluster Services software will not protect against such faults.

Rules for Operating a NetWare Cluster Services SAN

When you create a NetWare Cluster Services system that utilizes shared 
storage space (a Storage Area Network, or SAN), it is important to remember 
that all servers attached to the shared device, whether in the cluster or not, 
have access to all of the volumes on the shared storage space unless you 
specifically prevent such access. NetWare Cluster Services arbitrates access to 
shared volumes for all cluster nodes, but cannot protect shared volumes from 
being corrupted by noncluster servers.
�� Overview and Installation
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Installation and Setup ��

When working with shared storage, failure to observe the following rules will 
result in data corruption or volume loss:

� Do not attach a noncluster server to the same shared storage device as a 
cluster unless you have isolated the storage so that the noncluster server 
has access only to its own volumes.

� Do not install NetWare on a server that is already attached to shared 
storage. The NetWare install will delete all NetWare partitions that it finds 
on local and shared storage devices. You must disconnect the shared 
storage device from the server before installing NetWare.

� Do not perform NSS cluster volume operations (deleting, resizing, 
renaming, etc.) from noncluster nodes. A cluster node is a NetWare server 
that is running the NetWare Cluster Services NLMs.

Installing or Upgrading NetWare Cluster Services

It is necessary to run the NetWare Cluster Services installation program when 
you 

� Create a new cluster.

� Add new nodes to an existing cluster.

� Upgrade NetWare Cluster Services software in an existing cluster.

If you are running the NetWare Cluster Services installation program to create 
a new cluster, the program automatically

� Creates a new Cluster object in NDS.

� Installs NetWare Cluster Services software on the servers you specify to 
be part of your cluster.

� Updates the AUTOEXEC.NCF file on each of the servers in your cluster. 
Note changes to AUTOEXEC.NCF:

NSS is replaced with NSS/AUTODEACTIVATE VOLUME=ALL

NetWare Cluster Services automatically mounts cluster volumes on 
specified servers in the cluster. This command ensures that cluster 
volumes don’t accidently get mounted on multiple servers in the cluster, 
which would cause data corruption.

After running the NetWare Cluster Services installation the first time to create 
a new cluster, you will need to run the NetWare Cluster Services installation 
again each time you want to add new servers to your cluster or upgrade 
NetWare Cluster Services software on an existing cluster. 
Overview and Installation
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NetWare Cluster Services Licensing

NetWare Cluster Services changes the licensing scheme currently provided 
with NetWare 5. The license changes performed by the NetWare Cluster 
Services installation depend on whether you have a Master License 
Agreement (MLA). Changes to NetWare 5 non-MLA licensing include:

� The server base licenses for each cluster server are deleted and are 
replaced with a server base license upgrade. This server base license 
upgrade works specifically with NetWare Cluster Services. 

The server base license upgrade is installed when you install NetWare 
Cluster Services and is placed in the same context as its Server object.

� All server connection licenses for each cluster server are deleted, and are 
all replaced with one or more Cluster User Access Licenses (CUAL). You 
need one or more CUALs to equal the number of connections for the 
server connection licenses that are deleted. The CUAL is an object in the 
NDS database and acts as a holding container for connections. This 
means that clients connecting to any cluster server can draw connections 
from the CUAL as needed, as long as there are still connections available.

The CUAL is installed when you install NetWare Cluster Services and is 
by default placed in the same context as the Cluster object. In order for 
users to get connections to servers in the cluster, CUALs need to be 
accessible to User objects. This means individual CUALs need to be 
placed at or above the users context in the NDS tree so they are accessible. 

� The Cluster Server License is a new license type and is required on every 
server you have in your cluster. The Cluster Server License allows a 
server to join a cluster.

The Cluster Server License is installed on a server when you install 
NetWare Cluster Services on that server. The Cluster Server License 
object is created in the same context as the Cluster object.

In most cases, the Cluster Server License is the only license required by 
NetWare Cluster Services if an MLA license is present in the Directory tree. 
The NetWare Cluster Services installation will automatically detect whether 
an MLA exists in the Directory tree and if so, install only the Cluster Server 
License.

For more information on Novell Licensing Services go to Novell’s 
documentation Web site (http://www.novell.com/documentation/lg/nls501/
docui/index.html).
�� Overview and Installation
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Run the Installation Program

To launch the installation program, download the product from Novell’s Web 
site (http://support.novell.com/misc/patlst.htm#nw) or insert the NetWare 
Cluster Services CD and complete the following steps:

� From the root of the NetWare Cluster Services CD or product download, 
launch Install.exe.

Continue through the installation screens until you get to the screen that 
prompts you to create a new cluster, add new nodes to an existing cluster, 
or upgrade software in an existing cluster.

� Select Create a New Cluster, Add New Nodes to Existing Cluster, or 
Upgrade Software in Existing Cluster, then click Next.

� Do one of the following:

� (If creating) Enter the name for the new Cluster object you are 
creating and specify the Directory tree and context where you want 
it created. Then click Next.

� (If adding new nodes) Specify the Directory tree, context, and name 
of the cluster you will add servers to. If you don’t know a cluster 
name, browse and select one from the list. Then click Next.

� (If upgrading software) Specify the Directory tree, context, and name 
of the cluster in which software is to be upgraded. Then click Next 
and go to Step 6 on page 20.

� Enter the name of the server you want to add to the cluster, or browse and 
select one from the list, and then click Add to Cluster. Repeat this step for 
every server you want to add to the cluster. Then click Next.

You can also remove servers you just added to the cluster by selecting 
them from the NetWare Servers in Cluster list and clicking Remove.

When you add a server to a cluster, NetWare Cluster Services 
automatically detects the server’s IP address. If the server you are adding 
has more than one IP address, you will be prompted to select the IP 
address you want NetWare Cluster Services to use.

� (Conditional) If you are creating a new cluster, specify whether your 
cluster has a shared disk system and if so, select the drive where you want 
the small cluster partition created. Then click Next.
Installation and Setup ��
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NetWare Cluster Services requires a small cluster partition on the shared 
disk system. You are also given the option of mirroring the partition for 
greater fault tolerance.

,03257$17��You must have at least 10 MB of free space that is not part of an 
NSS partition on one of the shared disk drives to create the cluster partition. If no 
free space is available, the shared disk drives can’t be used by NetWare Cluster 
Services.

� Choose whether or not you want the servers you are upgrading or adding 
to your cluster to reboot after installation, then click Next.

The installation program installs or upgrades NetWare Cluster Services 
software on the servers in your cluster. It does not automatically load the 
software on the servers in your cluster. Unless you have an immediate 
need to keep your cluster servers running, you should choose to have your 
servers reboot after the installation is complete. This will ensure that 
NetWare Cluster Services software properly loads on new or upgraded 
servers in your cluster.

If you are upgrading software on an existing cluster, go to Step 8 on page 
21.

� Specify the location of the license files and click Add, then click Next.

License files are located on the license diskettes included in the NetWare 
Cluster Services product box. The Cluster Server License diskette 
contains two Cluster Server Licenses, two Server Base License Upgrades 
and one 10-user CUAL. Cluster Server licenses are the only licenses 
required for most MLA customers. Additional CUALs, Server Base 
License Upgrades, and Cluster Server Licenses can be obtained from 
your Novell Authorized Reseller.

If you do not have a Master License Agreement, you will be prompted for 
an activation key for each node you add to a cluster. Obtaining activation 
keys will require you to provide the serial numbers for the licenses you 
are upgrading. Activation keys can be obtained at Novell’s Web site 
(http://www.novell.com/products/activation).

You are given the option of installing with or without licenses. If you 
choose to install without licenses, you will need to manually install the 
necessary licenses at a later date using NetWare Administrator. NetWare 
Cluster Services will not function without the proper licenses in place.
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� Continue through the final installation screen.

� If you are creating a new cluster, the installation program will create 
a new cluster object in NDS and install NetWare Cluster Services 
software on the servers you specified to be part of your cluster.

� If you are adding new nodes to an existing cluster, the installation 
program will install NetWare Cluster Services software on the 
servers you are adding to your cluster.

� If you are upgrading NetWare Cluster Services software on an 
existing cluster, the installation program will upgrade cluster 
software on all servers in the cluster.

Setting Up NetWare Cluster Services

If you created a new cluster, you now need to create and configure cluster 
resources, and if necessary, configure all shared disk system volumes to use 
Novell Storage Services and create cluster volumes.

While ConsoleOne is required for most cluster-related tasks, you can use 
NetWare Administrator to modify trustee assignments on files, directories, 
and cluster-enabled volumes. To use NetWare Administrator to modify 
trustee assignments, you will first need to establish a connection to the server 
or cluster-enabled volume.

Create Cluster Volumes

If you plan on using a shared disk system in your cluster and need to create 
new NetWare volumes after installing NetWare Cluster Services, the server 
used to create the volumes should already have NSS installed and running.

After creating the volumes, bring up the other servers in the cluster. 
Depending on your configuration, the new volumes will either mount 
automatically when resources that require them start or will have to be 
mounted manually on individual servers after they are up.

If you have a volume that is not being managed by NetWare Cluster Services, 
the volume will need to be mounted before you can access it. The MOUNT 
ALL command in AUTOEXEC.NCF will no longer mount all NSS volumes 
by default. Add separate MOUNT commands for each of the volumes you 
want to mount (from AUTOEXEC.NCF). Add the MOUNT command 
followed by the volume name to the AUTOEXEC.NCF file of the server 
where the volume is to be mounted.
Installation and Setup ��

Overview and Installation
Place Part Number Here

February 5, 2001



Manual Rev 99a28 9 June 00
Cluster-Enable Volumes 

If you have a shared disk system that is part of your cluster and want the 
volumes on the shared disk system to be highly available to NetWare clients, 
you will need to cluster-enable those volumes. Cluster-enabling a volume 
allows it to be moved or mounted on different servers in the cluster in a 
manner that supports transparent client reconnect.

Some server applications don’t require NetWare client access to volumes, so 
cluster-enabling volumes might not be necessary.

� In ConsoleOne, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Volume.

� Browse and select a volume on the shared disk system to cluster-enable.

� Enter an IP address for the volume.

Each volume you cluster-enable requires its own IP address.

� Click Create, then continue with “Set Start, Failover, and Failback 
Modes” on page 26.

To complete the process for cluster-enabling a volume, you now need to 
set failover and failback modes and if necessary, change the node 
assignments for the volume (See “Assign Nodes to a Resource” on page 
27).
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Create Cluster Resource Templates

Templates simplify the process of creating similar or identical cluster 
resources. For example, templates are helpful when you want to create 
multiple instances of the same resource on different servers. You can create 
templates for any server application or resource you want to add to your 
cluster.

NetWare Cluster Services currently provides templates for GroupWise®, 
Oracle*, and Netscape Enterprise Server*, as well as a generic IP SERVICE 
template. The generic IP SERVICE template can be used when configuring 
certain server applications to run on your cluster. You can edit and customize 
any of the templates for your specific needs.

� In ConsoleOne, browse and select the Cluster object where you want to 
create a cluster resource template.

� From the menu bar, click File > New > Cluster > Cluster Resource.

� Enter a name for the new cluster resource template.

� Check the Create Cluster Resource Template check box.

This option lets you create a cluster resource template instead of a cluster 
resource.

� Check the Define Additional Properties check box, then continue with 
“Configure Load Scripts” on page 24.

To finish creating a cluster resource template, you need to configure load 
and unload scripts, set failover and failback modes and, if necessary, 
change the node assignments for the resource template.

Create Cluster Resources

Cluster resources must be created for every resource or application you run on 
servers in your cluster. Cluster resources can include Web sites, e-mail servers, 
databases, and any other server-based applications or services you want to 
make available to users at all times.

� In ConsoleOne, browse and select the Cluster object you want to create 
resources for.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the new cluster resource.

� If a template exists for the resource you are creating, enter the template 
name in the Inherit From Template field, or browse and select it from the 
list. If a template does not exist, check the Define Additional Properties 
check box.
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� Click Create.

� (Conditional) If you are not using a template for the resources, continue 
with “Configure Load Scripts” on page 24.

If you are not using a template, you must complete the process for 
creating the cluster resource by configuring load and unload scripts, 
setting failover and failback modes, and if necessary change the node 
assignments for the resource.

If you are using a template for this resource, additional resource 
configuration is performed automatically by the template.

More information on cluster resource configuration is available at 
Novell’s documentation Web site (http://www.novell.com/
documentation/lg/ncs/docui/index.html).

Configure Load Scripts

A load script is required for each resource, service, or volume in your cluster. 
The load script specifies the commands to start the resource or service on a 
server, or to mount the volume on a server. 

You can use any commands in the load script that would be used in an .NCF 
file run from the server console. If you don’t know which commands to add to 
your load script, consult the documentation for the application or resource.

� Select the Load Script tab on the property page.

� Edit or add the necessary commands to the script to load the resource on 
the server.

Some commands may require command line input. You can add << to a 
command to indicate command-line input. For example, a script 
command might read: 

LOAD SLPDA <<Y
�
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This means that when SLPDA is loaded, it will receive a Y at the 
command-line, presumably to a question that needs a yes answer. If there 
are more inputs required, they can be continued on subsequent lines, as 
follows:

LOAD SLPDA <<Y

<<Y

<<N

The string can be up to 32 characters.

� Specify a timeout value.

The default is 600 seconds, or 10 minutes. The timeout value determines 
how much time the script is given to complete. If the script does not 
complete within the specified time, the resource becomes comatose.

Configure Unload Scripts

Depending on your cluster application or resource, you can add an unload 
script to specify how the application or resource should terminate. An unload 
script is not required by all resources or applications, but it can ensure that 
during a failback or manual migration, a resource unloads before it loads on 
another node. Consult your application vendor or documentation to determine 
if you should add commands to unload the resource.

� Select the Unload Script tab on the property page.

� Edit or add the necessary commands to the script to unload the intended 
resource on the server

You can use any commands used in an .NCF file run from the server 
console. If you don’t know which commands to add, consult the 
documentation for the application or resource you want to unload.

� Specify a timeout value.

The default is 600 seconds, or 10 minutes. The timeout value determines 
how much time the script is given to complete. If the script does not 
complete within the specified time, the resource becomes comatose.
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Set Start, Failover, and Failback Modes

You can configure start, failover and failback of cluster resources to happen 
manually or automatically. With the resource Start Mode set to AUTO, the 
resource will automatically start on a server when the cluster is first brought 
up. If the resource Start Mode is set to MANAUL, you can manually start the 
resource on a server when you want, instead of having it automatically start 
when servers in the cluster are brought up. 

With the resource Failover Mode set to AUTO, the resource will automatically 
start on the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the resource Failover Mode is set to MANUAL, you can 
intervene after a failure occurs and before the resource is moved to another 
node.

With the resource Failback Mode set to DISABLE, the resource will not 
failback to its most preferred node when the most preferred node rejoins the 
cluster. If the resource Failback Mode is set to AUTO, the resource will 
automatically failback to its most preferred node when the most preferred 
node rejoins the cluster. Set the resource Failback Mode to MANUAL to 
prevent the resource from moving back to its preferred node when that node 
is brought back online, until you are ready to allow it to happen.

To set resource Start, Failover, and Failback modes:

� In ConsoleOne, right click the resource object and select Properties, then 
select the Policies tab on the property page.

� Check the Ignore Quorum check box if you don’t want the cluster-wide 
timeout period and node number limit enforced. 

The quorum default values were set when you installed NetWare Cluster 
Services. You can change the quorum default values by accessing the 
properties page for the Cluster object. 

� Choose the Start, Failover and Failback modes for this resource. 

The default for both Start and Failover modes is AUTO, and the default 
for Failback mode is DISABLE.
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Assign Nodes to a Resource

When you create a resource on a cluster or cluster-enable a volume, the nodes 
in the cluster are automatically assigned to the resource or volume. The order 
of assignment is the order the nodes appear in the resource list. You can assign 
or unassign nodes to the resource or volume, or change the failover order.

� Select the Nodes tab on the property page.

� From the list of unassigned nodes, select the server you want the resource 
assigned to and click the right arrow button to move the selected server to 
the Assigned Nodes list. 

Repeat this step for all servers you want assigned to the resource. You can 
also use the left arrow button to unassign servers from the resource.

� Click the up and down arrow buttons to change the failover order of the 
servers assigned to the resource or volume.

Configuration Settings

Depending on your needs and cluster setup, some additional configuration 
may be required for you to effectively use NetWare Cluster Services. This 
additional configuration consists of changing the network settings on the 
clients that will access the cluster. You might also need to change the values 
on some of the properties for the Cluster object and the Cluster Node objects.

Client Configuration

Certain advanced settings are required for older Windows 95/98 and all 
Windows NT clients to transparently reconnect or access cluster enabled 
volumes in NetWare Cluster Services. These advanced settings are only 
required for Windows 95/98 clients that are earlier than version 3.10, Support 
Pack 2 (the client version that ships with NetWare Cluster Services). Use the 
following intructions to ensure workstations are properly configured.

127(��Autoreconnect only works for volumes that are cluster-enabled.

For older Windows* 95/98 clients:

� In the Control Panel, select Network, then select Novell NetWare Client.

� Click Properties. 

� Select the Advanced Settings tab.
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� Verify or change the settings to the following:

Auto Reconnect Level=3
Auto Reconnect Timeout=default
Handle Net Errors=ON
Name Cache Level=0
Net Status Timeout=60
Netware Protocol=NDS

For all Windows NT* clients:

� In the Control Panel, select Network, then select Services.

� Select Novell Client for NT and verify or change the following settings.

On the Advanced Settings tab:

Auto Reconnect=ON

On the Protocol Preferences tab:

Preferred Network Protocol=IP
Protocol Component Settings=NDS

NetWare Cluster Services requires that NetWare clients be configured to use 
TCP/IP for transparent client reconnect. NetWare clients configured to use 
only IPX cannot map drives to the shared disk volume through NDS. IPX 
clients can however map drives to the shared disk volume through the server 
that currently has the volume mounted. When a failover occurs, the 
connection to the share disk volume fails and a new drive mapping must be 
manually created to the volume through the server where the volume has 
migrated.

Edit Quorum Membership and Timeout Properties

To edit Quorum Membership and Timeout properties, in ConsoleOne, right 
click the Cluster object and select Properties. This will bring up the Cluster 
Object Property page. Select the Quorum tab.
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Membership

The Quorum Membership is the number of nodes that must be running in the 
cluster before resources will start to load. When you first bring up servers in 
your cluster, NetWare Cluster Services reads the number specified in the 
Membership field and waits until that number of servers is up and running in 
the cluster before it starts loading resources. Set the Membership value to a 
number greater than 1 so that all resources don’t automatically load on the first 
server that is brought up in the cluster. For example, if you set the Membership 
value to 4, there must be four servers up in the cluster before any resource will 
load and start.

Timeout

Timeout specifies the amount of time to wait for the number of servers defined 
in the Membership field to be up and running. If the timeout period elapses 
before the quorum membership reaches its specified number, resources will 
automatically start loading on the servers that are currently up and running in 
the cluster. For example, if you specify a Membership value of 4 and a timeout 
value equal to 30 seconds, and after 30 seconds, only two servers are up and 
running in the cluster, resources will begin to load on the two servers that are 
up and running in the cluster.

Cluster Protocol Properties

You can use the Cluster Protocol property pages to view or edit the transmit 
frequency and tolerance settings for all nodes in the cluster, including the 
master node. The master node is generally the first node brought online in the 
cluster, but if that node fails, any of the other nodes in the cluster can become 
master.

To view or edit Cluster Protocol properties, in ConsoleOne, right click the 
Cluster object and select Properties. This will bring up the Cluster Object 
property page. Select the Protocol tab. This tab has two pages, Settings and 
Internals. The Internals page lets you view the script used to configure the 
cluster protocol settings, but not change it. Use the Settings page to make 
changes to cluster protocol properties.
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Heartbeat

Heartbeat specifies the amount of time between transmits for all nodes in the 
cluster except the master. For example, if you set this value to one, non-master 
nodes in the cluster will send a signal that they are alive to the master node 
every second.

Tolerance

Tolerance specifies the amount of time the master node gives all other nodes 
in the cluster to signal that they are alive. For example, setting this value to 
four means that if the master node does not receive an “I’m alive” signal from 
a node in the cluster within four seconds, that node will be removed from the 
cluster.

Master Watchdog

Master Watchdog specifies the amount of time between transmits for the 
master node in the cluster. For example, if you set this value to one, the master 
node in the cluster will transmit an “I’m alive” signal to all the other nodes in 
the cluster every second.

Slave Watchdog

Slave Watchdog specifies the amount of time the master node has to signal 
that it is alive. For example, setting this value to five means that if the non-
master nodes in the cluster do not receive an “I’m alive” signal from the 
master within 5 seconds, the master node will be removed from the cluster and 
one of the other nodes will become the master node.

Max Retransmits

This option is not currently used with NetWare Cluster Services but will be 
used for future versions.

Cluster Port Properties

The default cluster port number is 7023, and is automatically assigned when 
the cluster is created. The cluster port number does not need to be changed 
unless there is a conflict created by another resource using the same port 
number. If there is a port number conflict, change the Port number to any other 
value that doesn’t cause a conflict.
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To view or edit the Cluster Port property, in ConsoleOne, right click the 
cluster object and select Properties. This will bring up the Cluster Object 
property page. Select the Port tab.

Cluster Node Properties

You can use the Cluster Node property page to view or edit the cluster node 
number or IP address of the selected node or view the context for the NetWare 
Server object.

To view or edit Cluster Node properties, in ConsoleOne, select the Cluster 
object, right click the desired cluster node on the right side of the ConsoleOne 
display screen, and select Properties. This will bring up the Cluster Node 
property page. Select the Node tab.

Number+IP Address

Number+IP Address specifies the cluster node number and IP address for the 
selected node. If the cluster node number or IP address changes for the 
selected node, the new information is not automatically updated in NDS. Edit 
the information and click Apply to update the information in NDS.

NCP Server

The NCP Server field is used to view the context for the NetWare Server 
object. This field cannot be edited. 

Migrate Resources

You can migrate resources to different servers in your cluster without waiting 
for a failure to occur. You might want to migrate resources to lessen the load 
on a specific server, to free up a server so it can be brought down for scheduled 
maintenance, or to increase the performance of the resource or application by 
putting it on a faster machine.

Migrating resources allows you to balance the load and evenly distribute 
applications among the servers in your cluster.

� In ConsoleOne, browse and select the Cluster object that contains the 
resource you want to migrate.

Resources must be in a running state to be migrated.
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� Ensure the right half of ConsoleOne displays the Cluster View State by 
selecting View > Cluster State from the menu at the top of the screen.

� In the Cluster Resource List, select the resource you want to migrate.

The Cluster Resource Manager screen appears, displaying the server the 
selected resource is currently running on, and a list of possible servers to 
which you can migrate resources.

� Select a server from the list and click Migrate to move the resource to the 
selected server.

127(��If you select a resource and click Offline, the resource will be unloaded 
from the server. It will not load on any other servers in the cluster and will remain 
unloaded until you load it again. This option is useful for editing resources since 
resources can’t be edited while loaded or running on a server.

Identify Cluster and Resource States

The Cluster State view in ConsoleOne gives you important information about 
the status of servers and resources in your cluster. 

Cluster servers and resources display in different colors, depending on their 
operating state. When servers and resources are green, they are in a normal 
operating condition. When a server that has been part of the cluster is red with 
a break in the icon, it has failed. When a resource is red, it is waiting for 
administrator intervention. When a server is gray with no break in the icon, 
that server is not currently a member of the cluster, or its state is unknown. 
When a resource is blank or has no colored icon, it is unassigned, offline, 
changing state, or in the process of loading or unloading.

The yellow ball in the middle of the server icon designates the master server 
in the cluster. The master server is initially the first server in the cluster, but 
another server can become master if the first server fails.

The Epoch number indicates the number of times the cluster state has 
changed. The cluster state will change every time a server joins or leaves the 
cluster.

Clicking on the Event Log tab gives you a detailed history of your cluster. 
Every time the cluster state changes, a new event is added to the Event Log. 
You can sort the events in the log by clicking on the column headings of the 
table. You can reverse the sort order by pressing the Shift key while clicking 
on a column heading. You can also save the Event Log to a file.
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Clicking on the HTML Report tab in the Cluster State view screen launches a 
more detailed report of the state of your cluster. You can view this report or 
save it to an HTML file for printing or viewing with a browser.

The following table identifies the different resource states and gives 
descriptions and possible actions for each state.

Resource State Description Possible Actions

Alert Either the Start, Failover, 
or Failback mode for the 
resource has been set to 
Manual. The resource is 
waiting to start, failover, 
or failback on the 
specified server.

Click the Alert status 
indicator and depending 
on the resource state, 
you will be prompted to 
Start, Failover, or 
Failback the resource.

Comatose The resource is not 
running properly and 
requires administrator 
intervention.

Click the Comatose 
status indicator and 
offline the resource. 
Once resource problems 
have been resolved, the 
resource can be put back 
online (returned to the 
running state).

Unloading The resource is in the 
process of unloading 
from the server it was 
running on.

None.

Running The resource is in a 
normal running state.

Click the Running status 
indicator and choose to 
either migrate the 
resource to a different 
server in your cluster, or 
unload (offline) the 
resource.

Loading The resource is in the 
process of loading on a 
server.

None.
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Additional Cluster Operating Instructions

The following instructions provide additional information for operating 
NetWare Cluster Services.

Adding Free Space to an Existing Cluster-Enabled Volume

Perform this operation from the node where the volume is mounted. All other 
cluster nodes can remain up and running.

Unassigned There isn’t an assigned 
node up that the 
resource can be loaded 
on.

Click the Unassigned 
status indicator and if 
desired, Offline the 
resource. Offlining the 
resource will prevent it 
from running on any of its 
preferred nodes should 
any of them join the 
cluster.

NDS_Sync The properties of the 
resource have changed 
and the changes are still 
being synchronized in 
NDS.

None.

Offline Offline status indicates 
the resource is shutdown 
or is in a dormant or 
inactive state. 

Click the Offline status 
indicator and if desired, 
click the online button to 
load the resource on the 
best node possible, given 
the current state of the 
cluster and the 
resource’s preferred 
nodes list.

Quorum Wait The resource is waiting 
for quorum to be 
established so it can 
begin loading.

None.

Resource State Description Possible Actions
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Deleting a Cluster-Enabled Volume

1. Bring offline the cluster resource that is using the cluster-enabled volume.

2. Bring every cluster node down to a DOS prompt except for one.

,03257$17��If you have an NDS master replica in the cluster, it is best 
to have that node be the one left running

3. Using NSS Menu, delete the cluster-enabled volume. (You can optionally 
release ownership of the storage.)

4. Using ConsoleOne, delete the resource that was using the cluster-enabled 
volume.

5. Bring the other servers back up and allow them to join the cluster.

Installing NetWare on a Server That Will Be Added to an Existing 
Cluster

1. Install fiber-channel hardware. 

NetWare will automatically detect and load the proper drivers when it 
installs.

2. Remove the cable from the fiber-channel card on the new server.

3. Install NetWare, including the latest service pack, on the new server.

4. Reboot the server.

5. Reconnect the server to the shared storage by reconnecting the cable to 
the fiber-channel card.

6. Install NetWare Cluster Services on the new server.

7. If you have changed the failover order, add the new server to the failover 
list.

By default, NetWare Cluster Services will include all nodes on the 
failover list, including newly added nodes.

Readding a Node to a Cluster That Was Prevously in the Cluster

1. Remove the cable from the fiber-channel card on the server.

2. If necessary, install NetWare, including the latest service pack on the 
server using the same node name and IP address.
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3. If the cluster node object for the server is still present, use ConsoleOne to 
delete the object.

You can do this by going to the Cluster container, selecting the node in 
the right frame, and pressing Delete.

4. Reconnect the server to the shared storage by reconnecting the cable to 
the fiber-channel card.

5. Run the NetWare Cluster Services install.

The node will assume its former identity.

Running NSS Verify or Rebuild on a Cluster Volume

Bring offline the cluster resource that is using the cluster-enabled volume, and 
then run Verify or Rebuild from any cluster node.

NetWare Cluster Services Console Commands

TRUSTOOL is a server console command with three command-line options.

� TRUSTOOL <volname> DUMP lists to the screen and to 
SYS:ETC\TRUSTDMP.TXT all Distinguished Names and the state of 
the migration.

� TRUSTOOL <volname> FIX forces TRUSTMIG to finish a partial 
migrate back to the previous host server.
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� TRUSTOOL <volname> PURGE is used to delete bad Distinguished 
Names (DNs) in the TRUSTMIG.FIL file. You must first manually 
mount the volume before using TRUSTOOL with the PURGE option. 
This will rename TRUSTMIG.FIL to TRUSTMIG.BAK and make a new 
TRUSTMIG.FIL in the _NETWARE directory. Bad DNs occur because 
a user or group was deleted without removing trustee rights to files on the 
volume, or because NDS didn’t synchronize soon enough after new users 
with trustee assignments were added to the tree.

Occasional problems occur if a volume fails over immediately after a user 
is deleted who had trustee rights to that volume. If you experience errors 
when a volume fails over and its trustees migrate to the new server, you 
will need to run TRUSTOOL with the PURGE option to delete the user 
from the trustee database. You should review the errors and remove only 
those usernames that correspond with deleted users.

NetWare Cluster Services provides other server console commands to help 
you perform certain cluster related tasks. Type HELP CLUSTER at the 
console prompt to get information on the commands and their functions.
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